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About this manual1.

Copyright1.1.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB, and the contents thereof must not be imparted to a third party, nor
used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

Warranty

Please inquire about the terms of warranty from your nearest ABB representative.

http://www.abb.com/substationautomation

Disclaimer1.2.

The data, examples and diagrams in this manual are included solely for the concept or
product description and are not to be deemed as a statement of guaranteed properties.
All persons responsible for applying the equipment addressed in this manual must satisfy
themselves that each intended application is suitable and acceptable, including that any
applicable safety or other operational requirements are complied with. In particular, any
risks in applications where a system failure and/ or product failure would create a risk
for harm to property or persons (including but not limited to personal injuries or death)
shall be the sole responsibility of the person or entity applying the equipment, and those
so responsible are hereby requested to ensure that all measures are taken to exclude or
mitigate such risks.

This product is designed to be connected and to communicate information and data via
a network interface, which should be connected to a secure network. It is sole responsib-
ility of person or entity responsible for network administration to ensure a secure connec-
tion to the network and to establish and maintain any appropriate measures (such as but
not limited to the installation of firewalls, application of authentication measures,
encryption of data, installation of anti virus programs, etc) to protect the product, the
network, its system and the interface against any kind of security breaches, unauthorized
access, interference, intrusion, leakage and/or theft of data or information. ABB is not
liable for damages and/or losses related to such security breaches, unauthorized access,
interference, intrusion, leakage and/or theft of data or information.

This document has been carefully checked by ABB but deviations cannot be completely
ruled out. In case any errors are detected, the reader is kindly requested to notify the
manufacturer. Other than under explicit contractual commitments, in no event shall ABB
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be responsible or liable for any loss or damage resulting from the use of this manual or
the application of the equipment.

Conformity1.3.

This product complies with the directive of the Council of the European Communities
on the approximation of the laws of the Member States relating to electromagnetic
compatibility (EMC Directive 2004/108/EC) and concerning electrical equipment for
use within specified voltage limits (Low-voltage directive 2006/95/EC). This conformity
is the result of tests conducted by ABB in accordance with the product standards EN
50263 and EN 60255-26 for the EMC directive, and with the product standards EN
60255-1 and EN 60255-27 for the low voltage directive. The product is designed in
accordance with the international standards of the IEC 60255 series.

Trademarks1.4.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General information1.5.

This manual provides thorough information on Grid Automation Controller COM600
(later referred to as COM600) Web Human Machine Interface (WebHMI) and the central
concepts related to it. Information in this manual is intended for operators performing
configurations using the WebHMI.

Document conventions1.6.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the

keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing

the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy

a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.
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• The following convention is used for menu operations: MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30 .

• You can be asked to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Use of symbols1.7.

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.

The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.
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Terminology1.8.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

COM600 as a generic name for COM600S IEC and COM600F
ANSI products

COM600 Series; COM600

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Object; DO

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set

A physical device that behaves as its own communication node
in the network, for example, protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality, and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

Logical Node; LN

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block
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Abbreviations1.9.

DescriptionAbbreviation

Alarms and EventsAE

Data AccessDA

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Web Human Machine InterfaceWebHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

Local Area NetworkLAN

Logical DeviceLD

Logical NodeLN

Network Control CenterNCC

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Programmable Logic ControllerPLC

Program Organization UnitPOU

Request To SendRTS

Substation AutomationSA

Substation Configuration DescriptionSCD

Substation Configuration LanguageSCL

Sequential Function ChartSFC

Single Line DiagramSLD

eXtended Markup LanguageXML

Related documents1.10.

MRS numberName of the manual

1MRS756125COM600 User’s Manual

1MRS756705COM600 Operator's Manual

1MRS756739COM600 Data Historian Operator's Manual

1MRS755001COM600 Sequence Control Configuration Manual
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MRS numberName of the manual

1MRS758689Master Protocols (Ethernet based) Configuration and Operation
Manual

1MRS758690Master Protocols (Ethernet based) Technical Reference Manual

1MRS758691Slave Protocols (Ethernet based) Configuration and Operation
Manual

1MRS758692Slave Protocols (Ethernet based) Technical Reference Manual

1MRS756567DNP 3.0 Serial Master (OPC) User's Manual

1MRS755495DNP 3.0 Serial Slave (OPC) User's Manual

1MRS755382IEC 60870-5-101 Slave (OPC) User's Manual

1MRS756703IEC 60870-5-101 Master (OPC) User's Manual

1MRS752278IEC 60870-5-103 Master (OPC) User's Manual

1MRS756738COM600 Logic Processor User's Manual

1MRS756126Modbus Serial Master (OPC) User's Manual

1MRS756913Modbus Serial Slave (OPC) User's Manual

Document revisions1.11.

HistoryProduct revisionDocument version/date

Document created3.3A/13.2.2009

Document revised3.4B/06.11.2009

Document revised3.5C/30.6.2011

Document revised4.0D/31.5.2012

Document revised4.1E/13.3.2015

Document revised5.0F/24.5.2017

Document revised5.1G/22.3.2018
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Introduction2.

General information about the COM600 series2.1.

The COM600 product series are versatile Substation Management Units that help realize
smart substation and grid automation solutions in industrial and utility distribution net-
works.

They get deployed together with protection and control IEDs, substation devices such
as RTUs, meters and PLCs in dedicated cabinets and switchgear.

The COM600 product is an all-in-one unit that functions as:
• Communication gateway
• Web Human Machine Interface (WebHMI)
• Automation controller
• Real-time and historical data management unit

The COM600 product series use process information and device data, acquired over
Ethernet or serial communication protocol interfaces to execute specific substation
functions and applications. Thus, they are critical building blocks to realize substation
secondary system solutions and in the process solving diverse customer needs.

COM600 product series variants and rationale2.2.

To facilitate substation and grid automation solutions in IEC and ANSI market areas, a
variant-based system similar to Relion® 615 and 620 series is being followed from
COM600 5.0 release.

The main reasons for such an approach are the following:

• To ensure all COM600 product series features are advantageously used in end-cus-
tomer projects in the medium voltage substation automation domain.

• To ensure an optimum feature set to be bundled together to realize specific applica-
tions required in IEC and ANSI market areas.

• To ensure a future-proof product approach.

This release then comprises of two variants, based on the primary intent or application
are defined as follows:
• COM600S IEC – COM600 for substation automation, analysis and data management

(for IEC markets)
• COM600S IEC is a substation automation, analyzer and data management unit

that integrates devices, facilitates operations, manages communication and runs
analysis applications pertinent to equipment or operations in utility or industrial
distribution substations.

• COM600F ANSI – COM600 as distribution automation controller (for ANSI markets)
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• COM600F is a dedicated distribution automation controller unit that runs dis-
tributed grid and feeder applications for ANSI power networks and inherits all
core features of the COM600 series.

Overview of COM6002.3.

COM600 provides gateway functions for mapping signals between protection and control
IEDs in industrial or utility substations and higher-level systems. It further includes an
optional WebHMI that provides data and information from the substation to the users.

COM600 gathers data from protection and control IEDs and from process devices using
different communication protocols. The supported protocols can be combined freely in
one station computer, limited only by the number of hardware interfaces and the license.
COM600 uses web technology to display data to different users in a professional and
user-friendly manner. The web technology is further used to transfer information to a
network control center (NCC) or distributed control system (DCS).

COM600 benefits from the potential of the IEC 61850 standard by using the IEC 61850-
6 substation configuration language (SCL) and IEC 61850 -7 communications modeling
regardless of protocol used. As the IEC 61850 data modeling is used for all communic-
ation protocols the gateway cross-reference is done in the same way regardless of the
protocol, for example IEC 61850-8-1 or DNP3. '

With the optional WebHMI, COM600 can be used for efficient substation visualization,
monitoring, and control. The supported browsers are Microsoft Internet Explorer, Mozilla
Firefox® and Google Chrome. Measured values from process devices are displayed on
the WebHMI. Single-line diagrams can be used to view any available measured values
from the process devices.

Predefined user account2.4.

The predefined COM600 user account also works as a WebHMI administrator user
account. It’s not possible to modify it in any way from the WebHMI though. It cannot
be deleted, it’s not possible to change its user group and its password must always be
changed from SAB600.
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Configuration3.

About this section3.1.

This section describes the configuration tasks for WebHMI.

Operating system access permissions using local
browser

3.2.

When using COM600 browser locally in the COM600 computer, it can be specified
whether the browser locks down the access to the operating system functions for non-
administrator users.

The C:\Program Files\COM610 GW SW\WebBrowser folder in the COM600 computer
contains a config.ini file, which has an option called useLockedMode. By default it is set
to value 0, which means that no locking is done. When set to 1, the access to operating
system functions is disabled from non-administrator users.

Prerequisites3.3.

Before you start configuring the WebHMI, pay attention to the following:
1. Prepare the communication structure as instructed in COM600 User's Manual.
2. Make sure that you have the necessary connectivity packages or SCL description

files that can help you in the configuration process.
3. Outline the Single Line Diagram structure you want to create for your system.

Use the Management function to update the COM600 communication configuration at
least once before you start the substation configuration. If you do not update the config-
uration, the statuses of objects in WebHMI Single Line Diagram can be bad or uncertain.

To fix the statuses of objects in Single Line Diagram:
1. Save the substation configuration.
2. Update the COM600 configuration with the Management function by changing any

property in SLD Editor and by clicking Apply.
3. Update the COM600 configuration again using with the Management function.

13

COM600 series 5.11MRS756740

HMI Configuration Manual



Creating substation structure and communication
structure

3.4.

Creating substation and communication structures with SCL
descriptions or connectivity packages

3.4.1.

To create the substation and communication structures with SCL descriptions or con-
nectivity packages:
1. Create Substation and Voltage level objects to the substation structure.
2. Create the OPC Server and communication channel objects to the communication

structure.
3. Create the IED object below the communication channel and use either the connectiv-

ity package or IED SCL description file to populate automatically the structure
below the IED. The substation structure is automatically populated with primary
apparatus objects described in the connectivity package or SCL descriptions. You
may be prompted to give some information to guide the process, for example choose
a voltage level or give a bay name.

4. Repeat step 3 for each IED.
5. Fine-tune the SLD layout (assign colors, specify incoming/outgoing feeders, and

so on) by modifying or adding objects. Additionally you might need to create busbar
connections, see 3.4.2,  Creating substation structure manually .

6. Download the configuration to the COM600 computer.

Creating substation structure manually3.4.2.

The following is an overview of creating a substation structure manually. For a more
detailed description, see 3.4.3, Adding Gateway object, 3.4.4, Adding Substation,
3.4.5, Adding voltage level object, 3.4.6, Adding bay object and 3.4.7, Adding busbar
object.

Before you can create a substation structure, you have to create
a communication structure with OPC Server and communica-
tion channel objects, IEDs, Logical Devices, Logical Nodes
and Data objects.

To create the substation structure manually:
1. Create Gateway, Substation and Voltage level objects to the substation structure.
2. Add bays and busbars, and design their layout using the SLD Editor. Connect your

substation structure objects to communication structure (logical nodes) using the
data connection function, see 3.6.1, General information about Data connection .
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If the configurations of the bays are similar, you can copy the
bay object and the data it contains. This way you do not have
to add each bay separately to the substation structure.

3. Design your voltage level layout by connecting busbars and bays and relocating
them with the SLD Editor. Open the SLD Editor by right-clicking the voltage level
object.

4. Design your substation layout by connecting possible transformer windings between
voltage levels. Relocate voltage levels with the SLD Editor. Open the SLD Editor
by right-clicking the substation.

5. Fine-tune SLD settings, for example fonts and colors, see 3.6.2, Settings .

Adding Gateway object3.4.3.

To link the Gateway object to the substation structure:
1. Select the Gateway object in the Communication structure.
2. Copy the Gateway object by selecting Edit > Copy or by right-clicking the object

and selecting Copy.
3. Open the Substation structure.
4. Select the project name and right-click it.
5. Select Paste Link, see Figure 3.4.3-1.
6. Modify the Gateway properties if necessary.

linkGW.bmp

Figure 3.4.3-1 Linking a Gateway object

The object properties for the Gateway are presented in Table 3.4.3-1.

Table 3.4.3-1 Object properties for Gateway
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic
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DescriptionVale or Value range/DefaultProperty/Para-
meter

Defines if local audio alarm is enabled in
COM600 hardware.

True

False

Default: True

COM600 Audio
Alarm

Version of COM600.Default: 3.3COM600 Version

Defines the path where event list log is
store.

Default: noneEvent File Path

Defines the capacity of Event List in
WebHMI.

0...65535

Default: 1000

Event List Capacity

Defines which WebHMI client IP
addresses are reserved for local use inside
station. This information is used for the
station/remote switch handling. E.g.
"192.168.7."

Station/remote IP
Address

Defines if Watch Dog is enabled.True

False

Default: True

Watch Dog Enabled

Defines if audio alarm is enabled for the
WebHMI clients.

True

False

Default: True

Web Client Audio
Alarm

External Watchdog

The full path of the command OPC item.
E.g.
"ABB.SPA_OPC_DA_Server.Instance[1]#SPAChan-
nel\SPA-
COM\SACO16D2B\LD1\LLN0\Wd\ctlVal".

Command OPC
Item Path

The interval in seconds that determines
how often the command is executed.

0...65535

Default: 5

Command Write
Interval

The value that is written to the command
OPC item.

0...65535

Default: 1

Command Write
Value

DCOM

IP address of COM600 computer.IP Address

Adding Substation3.4.4.

After the Gateway object has been successfully added, you can continue building the
object tree by adding substation objects.
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To add a substation object:
1. Select the Gateway object and right-click it.
2. Add a substation object by selecting New > Functional > Substation.
3. Rename the new object. The names of the substation objects have to be unique.
4. Modify substation properties if necessary.

You can define only one substation per project.

Adding voltage level object3.4.5.

After the substation object has been successfully added, you can continue building the
object tree by adding voltage level objects.

To add a voltage level object:
1. Select the substation object and right-click it.
2. Add a voltage level object by selecting New > Functional > Voltage Level.
3. Rename the new object. The names of the voltage level objects have to be unique.
4. Modify voltage level properties if necessary.

The object properties for voltage level are presented in Table 3.4.5-1.

Table 3.4.5-1 Object properties for voltage level
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic

MultiplierDefault: kiloMultiplier

Nominal voltage.20Voltage

Library References

Add/delete reference links to files in Docu-
ment Library.

References

Adding bay object3.4.6.

After the voltage level object has been successfully added, you can continue building
the object tree by adding bay objects.

To add a bay object:
1. Select the voltage level object and right-click it.
2. Add a bay object by selecting New > Functional > Bay.
3. Rename the new object. The names of the busbar objects have to be unique.
4. Modify bay properties if necessary.
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5. Design the bay layout using SLD editor, see 3.5.1, Using the SLD Editor.
6. Use the data connection function, see 3.6.1, General information about Data connec-

tion.

Adding busbar object3.4.7.

After the voltage level object has been successfully added, you can continue building
the object tree by adding busbar objects.

To add a busbar object:
1. Select the voltage level object and right-click it.
2. Add a busbar object by selecting New > Functional > BusBar.
3. Rename the new object. The names of the busbar objects have to be unique.
4. Modify busbar properties if necessary.
5. Design the busbar layout using SLD editor, see 3.5.1, Using the SLD Editor.

Single Line Diagram3.5.

Using the SLD Editor3.5.1.

To open the SLD Editor, select substation, voltage level, bus, or bay object and right-
click them. Then select SLD Editor from the menu. The higher level contains the layout
of the lower levels.

With the SLD Editor you can add objects to the Single Line Diagram, modify existing
objects, and specify electrical connections. You can also fine-tune the layout of the dia-
gram and add and modify descriptive texts. You can drag and drop symbols needed in
the SLD from the symbol library. Click Preview to preview the layout of the diagram.
The supported browsers are Microsoft Internet Explorer, Mozilla Firefox, and Google
Chrome.
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SLDPreview.bmp

Figure 3.5.1-1 SLD Editor preview

To open the SLD Editor Tool:
1. Click the Substation structure tab.
2. Select the Bay or the Busbar object.
3. Right-click on the Bay or the Busbar object and select SLD Editor.

or
From the main toolbar, select Tools > SLD Editor.

Creating a diagram with the SLD Editor

To create a diagram with the SLD Editor:
1. In the Symbols view, click the tabs to view the different sets of symbols, see Fig-

ure 3.5.1-2.
2. Click a symbol you want to use and drag it with the mouse to the Single Line Diagram

view.
3. Place Connectivity Nodes between switches and transformers that will be connected.
4. Select the Direct Link tool from the SLD toolbar. Link the symbols together by

clicking first the start and then the end point of a connection.
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Symbols can be graphically grouped by drawing a rectangle border around them by
selecting the Rectangle button. This feature is only a visual aid and does not affect the
functionality of the SLD.

SLD_symbols.bmp

Figure 3.5.1-2 SLD symbols

Bay SLD

To create a bay SLD:
1. Add primary objects (Switchgear objects, measurement transformers, and power

transformers).
2. Rename the primary object using the name property in the property grid. This name

is used in WebHMI for the object.
3. Add primary Connection objects (for example, feeders, earth symbols).
4. Add Connectivity Nodes.

• Switchgears are connected to each other with a connectivity node.
• Feeder objects are connected to switchgear objects with a connectivity node.
• Transformer objects are connected to switchgear objects with a connectivity

node.
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Do not add connectivity nodes to the connection between
the busbar and the bay switchgears.

Do not add connectivity nodes between the earth symbol
and the switchgear object (disconnector).

To connect a power transformer to another bay, create a
connectivity node in the target bay (not in the bay where
the power transformer is located).

Default relative sizes of the symbols can be configured
using the Settings tool of the Gateway object. Default
values can be overriden for individual symbol instances
with the Relative Size property of the symbol instance.
This makes it possible to have individual sizes for sym-
bols in the SLD.

5. Add Via points, if you want the line to follow a certain route.
6. Connect objects

• Activate the Direct Link tool from the tool bar.
• Link two objects together by selecting their link points.
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Additionally you can add for example a Bay Switch indicator, annotations, and
measurement text boxes.

Bay_SLD.png

Figure 3.5.1-3 The Bay SLD view
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Measurement text box configuration

To configure the Measurement text box, use the Data Connect
function to connect the measurement logical nodes from the
communication structure to the bay.

To configure the Measurement text box:
1. Right-click the object and select Configure Measurement function from the menu.
2. Using the configuration dialog, select the measurements to be shown in WebHMI.

If the IED does not provide a unit for the measurement, it is
possible to specify the unit here.

Measurement_configuration.png

Figure 3.5.1-4 The Measurement Configuration dialog
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Button configuration

To configure buttons, use the Data Connect function to connect
the measurement logical nodes from the communication
structure to the bay.

You can configure the following buttons:
• 2-State Indicator/Button is a button with two states: on (or pressed) and off (oth-

erwise). Optionally, you can click it to change the button to the opposite state. The
2-State Indicator/Button can be used, for example, to change IED's autoreclosing
mode or tap changer auto/manual mode.
• It’s possible to use this button type to control DPC data objects. In this case it’s

not necessary to configure any off and on values.
• Using the button in the indication-only mode with DPS data objects is also

supported. In this case the "On" value should be configured as “DPS” to enable
DPS semantics for the value, i.e. “Off” = 1, “On” = 2 and all other values are
invalid. Normally the configured "On" value decides the on state and all other
values are used for the off state.

• If a button using a DPC or DPS data object is updated with an invalid value,
then the button state will be neither on nor off, instead an invalid state will be
displayed.

• Push Button is a button that can only be clicked and has no state. Each time the
you click the button, it sends a command to the process. The Push Button can be
used, for example, to trigger a disturbance recording.

• Push Button With Value is a variation of a Push Button. It allows the command
value to be specified manually each time instead of using a pre-configured command
value like Push Button. The Push Button With Value can be used to send an integer
or a float value to a certain data object. An optional indication will be used to retrieve
the current value to the command value input field of the opened control dialog.

• Multiple State Button is a button that has multiple states (at least two). Each state
needs to be configured. You can configure optional color and text for each state.
The Multiple State Button can be used, for example, to show the status of a sequence
step or health of an IED.

Bay Switch Indicator configuration

To configure the Bay Switch Indicator, use the Data Connect
function to connect the logical node containing the Loc
information (LLN0) from the communication structure to the
bay.
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To configure the Bay Switch Indicator:
1. Right-click the object and select Configure Bay Switch Indicator from the menu.
2. Using the configuration dialog, select the source for the local remote switch indication

(for example LLN0.Loc.stVal) to be used in WebHMI.

Bay_Switch_Indicator_configuration.png

Figure 3.5.1-5 The Bay Switch Indicator configuration dialog

Busbar SLD

To create a busbar SLD:
1. Add Busbar start and end objects (only one start and end point is allowed).
2. Add a Connectivity Node (one connectivity node is enough to connect all bays to

this busbar).
3. Connect the objects.

• Activate the Direct Link tool from the tool bar.
• Two objects linked together by selecting their link points.
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You can adjust the size of busbar in the bay and voltage level views as well as the busbar
view. You can also add annotations.

Busbar_SLD.png

Figure 3.5.1-6 The Busbar SLD view

Busbar Coloring

Busbar Coloring is automatically configured when the SLD is drawn. Connecting
switchgear objects together specifies their electrical connections, which is used during
runtime to calculate the proper coloring. Settings tool in the substation gateway object
has tab page for the Busbar coloring, where, for example, the used colors can be modified.
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The value of the voltage property on the voltage level object is used for the voltage level
based busbar coloring mode.

Configuring the powered state for incoming feeder and generator

1. Select the IFL or GEN object in the SLD editor.
2. Right-click it, and select Configure Powered Rule from the menu.

There are three different rules for detecting the powered state. Configure at least one of
the following three rules so that the busbar coloring works correctly.

• A measurement value must be greater than the configured value.
• A data object value is equal to the configured value.
• A data object value is unequal to the configured value.

If the result of all configured rules is true, the object is considered as powered by the
busbar coloring logic.

sldPoweredRule.png

Figure 3.5.1-7 The Powered rule dialog

Voltage level SLD

To create a voltage level SLD:
1. Drag the bays to correct locations in the SLD (name of the selected bay can be seen

in the property grid).
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2. Connect bays to busbars. Select a bay, right-click it and select Connect to a Busbar
from the menu.

3. In the configuration dialog, select the corresponding switchgear and the busbar
object to connect them.

4. If you need to connect a bay to another directly, select a bay, right-click it, and select
Connect to a Bay.
By doing this the bays will be connected via regular line.

The SLD Editor shows the lines between the bays and
the busbar connected to the same point in the busbar.
However, the lines are drawn to separate locations in
WebHMI.

5. If you want to fine-tune the SLD Editor layout for the connection lines, you can add
a StopAt object from menu of the line. Move the StopAt point to the correct location
in the busbar.
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You can also add annotations.

Voltage_level_SLD.png

Figure 3.5.1-8 The voltage level SLD view

Substation SLD

To create a substation SLD:
1. If you have more than one voltage level object, drag the objects to correct locations

in the SLD.
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2. Voltage levels are connected to each other via a power transformer. Select a voltage
level containing the transformer, right-click it and select Connect Winding to a bay
function from the menu.

3. Using the configuration dialog, you can select winding and the target bay/connectivity
node.

4. Add Station switch indicator (local/remote) Configuration.

To configure the Station Switch Indicator, use the Data Con-
nect function to connect the logical node containing the
information (SPS CDC) from the communication structure to
the substation.

SLD_Editor.png

Figure 3.5.1-9 Substation SLD view
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Multiple SLD views3.5.2.

COM600 WebHMI supports customized SLD views for substation, voltage level and
bay objects. By default, the different SLD views are based on the same master SLD
configuration, Master View.

Additionally, it is possible to create a bay-specific Bay View, for example, to give more
detailed information about the bay. The Bay View overrides the Master View when the
SLD is opened from the bay object in WebHMI. The substation and voltage level SLDs
always show the bay SLD as in the Master View configuration.

The different views can be modified on each level and the modifications affect only the
selected view. However, modifications on the Master View affect all other views.
Extension objects, such as different types of buttons, are view-specific and can only be
modified in the current view.

Master View

The Master View configuration is used for all views by default, when a customized
Substation View or Bay View has not been configured. The Master View must always
contain all the primary substation elements required in all views. Primary substation
elements are conducting equipment, power transformers and connectivity nodes. Busbar
coloring is based on the Master View.

Substation View (optional)

The Substation View can be used to override the substation SLD in the Master View.
The Substation View contains substation and substation extension elements that are
shown in the substation SLD in COM600 WebHMI. With the Substation View config-
uration it is possible to hide unnecessary elements from all levels.
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• Substation View configured on a substation object specifies which voltage levels
are shown on the substation SLD.

• Substation View configured on a voltage level object specifies which bays are
shown for that voltage level on the substation SLD.

• Substation View configured on a bay object specifies which conducting equipment
is shown for that bay on the substation SLD.

newsubstationViewFromBayLevel.png

Figure 3.5.2-1 An example of a Substation View
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Bay View (optional)

The Bay View can be used to override the bay SLD in the Master View. The Bay View
contains substation and substation extension objects. The substation extension objects
can be added to each view and they are bound to the view they are created on.

bayViewCreated.png

Figure 3.5.2-2 An example of a Bay View

Depending on the level, you can create the following views:
• On a bay level, you can create one Bay View and one Substation View.
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• On a voltage level, you can create one Substation View.
• On a substation level, you can create one Substation View. If a Substation View

has already been created for a particular substation or its child objects, it will be
reused for the whole substation section on each level.

If the Bay View has not been explicitly defined in SAB,
WebHMI will generate it on-demand when the operator opens
the Bay View. If the Substation View with the bay has been
defined, the on-demand Bay View is generated based on that.
If the Substation View does not contain the bay, the Bay
View is generated based on the Master View.

Custom Views (optional)

In addition to the Substation and Bay Views it is also possible to create any number of
Custom Views for the Substation, Voltage Level and Bay objects.
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SAB600_alternative_SLD_view.png

Figure 3.5.2-3 The Custom Views dialog

Custom Views are named and will appear as additional tree nodes under the object they
belong to in the WebHMI substation tree. To open a Custom View, just select the cor-
responding node in the tree.
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COM600_alternative_SLD_view.png

Figure 3.5.2-4 An example of a Custom View

The purpose of Custom Views is mainly to allow splitting up large views into multiple
smaller views that are more manageable for the WebHMI users.

Synchronizing views

The Synchronize Views functionality can be used to re-introduce removed symbols to
the views. It can be also used to remove objects from the views.
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synchViews.png

Figure 3.5.2-5 The Synchronize Views dialog

The Synchronize Views dialog shows all common objects for the selected bay, voltage
level or substation object. A column is shown for each created view. By selecting and
clearing the check boxes, you can decide which objects are shown in different views.

Data connection3.6.

General information about Data connection3.6.1.

The Data Connection function is used to connect the substation structure objects to the
communication structure. Process data values based on the communication structure
objects are used to update the symbol states in WebHMI. It is also used to get object
descriptions based on the substation structure names to the alarm and event lists.

Any data object that has event class defined in the communic-
ation structure, must be linked to the substation structure to
get the proper description to the alarm and event.
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Before you can use the Data connection function, create the communication structure,
see 3.4.1, Creating substation and communication structures with SCL descriptions or
connectivity packages.

To connect the substation structure objects to the communication structure:
1. In the Substation structure select a Substation, Bay, or Voltage level object and

right-click it. Select Data Connection to open the Data connection function.
The objects in the substation structure are shown on the left side of the Data connec-
tion window. The logical nodes that can be attached to the objects are shown on the
right side of the Data connection window.

2. Click a substation structure object on the left side of the Data connection window.
The logical nodes that can be attached to the objects are listed in the structure on
the right side of the window.

3. Double-click the logical node to attach/detach it to the correct substation structure
object.

4. Click OK to save the changes.

Data_connection.bmp

Figure 3.6.1-1 The Data connection window
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Settings3.6.2.

You can define SLD settings in the Settings dialog. To open the Settings dialog, right-
click the Gateway object and select Settings.

The Settings dialog contains the following tabs:
• Generic: You can define general settings, for example the symbol set (ANSI or

IEC) and element size.
• Alarm Settings: You can define color settings and appearance for the alarms.
• Measurement Status: You can define color settings for different alarm levels.
• Default Colors: You can modify the default colors of devices.
• Fonts: You can modify the font definitions.
• Measurement Precisions: You can adjust the precision settings of the measurements.
• Bus Bar Coloring: You can define busbar colors and busbar settings.
• Name Display: You can define name display settings. These settings define how

and if name is displayed next to the symbol.
• Resource Text Sets: You can modify measurement, quality, or local/remote resource

texts. Measurement texts affect the Measurements page of WebHMI. Quality texts
affect Alarm and Event Lists in WebHMI. Local/Remote texts are displayed with
the Bay and Station Indicator.

Measurement page configuration3.7.

The Measurement Page Configuration Tool can be started from the bay, voltage level,
or substation object in the Substation structure. The tool has two tabs: Measurement
Page and Options. The configurable properties for the measurements are shown in
Table 3.7-1.

In the Measurement Page Configuration Tool you can:
• browse all measurements objects.
• select / deselect measurements to the current measurement page and move the

selected measurements up or down in the measurement page.
• exclude unimportant measurement data objects from the measurement page.
• export the selected measurements as a re-usable template.
• select measurements according to a specified measurement template.
• save the current measurement page configuration.

Table 3.7-1 Properties for measurement configuration
DescriptionProperty

Select if signal is visible in the measurement view.Selected

Item path from IED to data attribute.Source

If defined, overrides the description from the IED configuration.Description

Defines whether the unit is shown.Show Unit

Defines the amount of decimals shown.Decimals
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DescriptionProperty

Defines the multiplier for the measurement.Display Multiplier

Overrides the unit which the IED is sending.Device Unit

Overrides the multiplier which the IED is sending.Device Multiplier

Document Library3.8.

The Document Library allows you can maintain a library of documents associated with
the SCL elements.

To add files to the Document Library:
1. Launch the Document Library from the gateway object in the substation view. The

Document Library window opens showing the files available in the library.

launch_document_library.png

Figure 3.8-1 Launcing the Document Library
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2. Click Add file to add new files to the library.

add_files_to_library.png

Figure 3.8-2 Adding files to the Document Library

3. Select a file to be added to the library, add a caption for the selected file, and click
Apply.

Editing Document Library references

You can add or remove references to documents in the Document Library.

To add/remove document references:
1. In the substation view, open the object properties window of the object you want to

add references to.
2. Click the References property to edit references to the documents in the Document

Library.

Substation Summary Table configuration tool3.9.

The substation Summary Table configuration tool can be started from the substation and
bay object in the substation structure.

In the Summary Table configuration tool you can:

• Create, delete, and rename pages which act as a logical container for different tables.
• Create or delete tables on each page.
• Manipulate tables by adding or removing rows or columns and re-positioning them.
• Bind cells to a data source for a dynamic status display.
• Save existing tables as templates for later use.
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Alarm and event handling3.10.

General information about alarm and event objects3.10.1.

Alarm and event objects define the types of events and alarms that are generated and the
alarm and event messages displayed in WebHMI. It is possible to to create new alarm
and event definitions (see 3.10.2, Creating event definitions) and configure existing
alarm and event definitions (see 3.10.3, Configuring event definitions ) and .

The communication structure contains the following event groups:
• Process Event Definitions
• Communication Diagnostic Event Definitions
• Common Event Settings

event_classes.bmp

Figure 3.10.1-1 Event groups

Creating event definitions3.10.2.

To create event classes:
1. Right-click the Events group in SAB600, see Figure 3.10.2-1.
2. Select  New -> Event classes.
3. Select the event class you want to add.
4. The new event class appears in the Process Definitions below the selected event

group. Enter a unique name for the event class by right-clicking it and selecting
Rename. The new event class can be configured and connected to a data object.
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createEventClass.png

Figure 3.10.2-1 An example of creating event classes

Configuring event definitions3.10.3.

You can configure event definitions in SAB600. Event definitions specify the type of
events that are created for WebHMI event and alarm lists. You can specify whether an
event appears only on the event list, on both event and alarm lists, or whether it is dis-
played at all. You can also add event texts for the events and specify whether alarms
must be acknowledged by the user.

Event definitions are linked to data objects by configuring the event properties available
for data objects. When importing IED configurations from connectivity packages or IED
SCL description files, event definitions are linked to data objects by default. For example
switch position data object CSWIx.Pos is linked by default to switch position event
definition. The default linking rules are specified in a DOParamsDefaults.xml file located
in the \Program files\ABB\COM600\bin\Tools\SCLImport in the computer where SAB600
is installed.

To configure event definitions:
1. Select the event you want to configure in the object tree.
2. The object properties appear now in the Object Properties window, see Figure 3.10.3-

1.
3. You can assign the event with parameter values.
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EventDefObjProp.jpg

Figure 3.10.3-1 An example of object properties of events

Connecting alarm or event objects to data objects3.10.4.

Data objects are connected to event classes by selecting the used event class from the
properties of the data object. Depending on the data class, the object can have an event
class property both for indication and control events or only one of them. These properties
define the event classes that are used with the data object.

Configuring event type filters3.10.5.

The Event Type Filter configuration tool allows you to create event type filters that are
displayed as additional columns, see Figure 3.10.5-1.

To create event type filters:
1. Right-click the Gateway object in the Communication structure and select Event

Type Filter.
2. Click Add Filter.
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3. Enter a name for the filter column and click Add.
4. To save the configuration to the Gateway object property, click Apply.

To remove filter types, open a context menu on any of the created columns and
select Delete.

Event_Type_Filter.png

Figure 3.10.5-1 An example of filters in the Event Type Filter configuration tool

Data Historian3.11.

The COM600 data historian is a real-time database designed and optimized for process
information management and extensive history recording. The data historian is based
on ABB’s cpmPlus Knowledge Manager software. It combines the benefits of an easy-
to-use real-time database with industrial reliability, performance, and real-time function-
ality to provide an excellent platform for process information management.

The data historian can be used for accurate process performance monitoring by following
process and equipment performance calculations with real-time and history values.
Better understanding of the process behaviour by joining time-based process measure-
ments with production and maintenance events helps the user to understand the process
dynamics. It further provides required information for learning how to keep the process
running. High performance and reliability, together with maintenance-free operation,
provide a solid platform for trending.

The optional data historian functionality offers means of storing, analyzing and
presenting process data.
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HMI_Data_Historian_menu.bmp

Figure 3.11-1 Data Historian menu item shown in WebHMI

For more information about configuring the data historian, see section Configuring Data
historian in COM600 User's Manual. For information about the actual usage of data
historian information, see COM600 Data Historian Operator's Manual.

Customizing IED parameter settings3.12.

To have the parameters of an IED added automatically to the selections list, the connectiv-
ity package for the IED that supports the parameter information must be installed.

With the Parameter Selection tool of SAB600, you can select the parameters that are
shown in the Parameter Setting view in WebHMI. This option helps you to create a user-
friendly view for WebHMI.

Selecting parameters

To select parameters:
1. Click the Communication tab on the left.
2. Right-click the IED object and select Parameter Filtering Tool. A Parameter Fil-

tering view opens. All the logical nodes the device contains are displayed on the
left side of the Parameter Filtering view.

3. Click a logical node to view all the possible parameters.
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4. Select the check box of the parameters you want to be displayed in the Parameter
Setting view of WebHMI, see Figure 3.12-1. To select all parameters, click Select
All. To unselect all parameters, click Deselect All.

5. Click Apply to save the selected parameters.

parameter_filtering_tool.bmp

Figure 3.12-1 Parameter Filtering Tool

Adding new parameters

You can add a new parameter to the Parameter Filtering view. If no connectivity package
is available or the connectivity package does not contain a specific parameter for your
needs, you can add new parameters using the Add Parameter Form.

To add a new parameter:
1. Click Add Parameter in the Parameter Filtering view. The Add Parameter Form

window opens, see Figure 3.12-2.
In the Add Parameter Form window you can fill in the information on the parameter
you want to add or select a suitable option from a drop-down list.

2. After you have added all necessary information, click Apply to add the parameter
to the Parameter Filtering view.

47

COM600 series 5.11MRS756740

HMI Configuration Manual



Add_parameter_form.bmp

Figure 3.12-2 The Add Parameter Form window

If a parameter row has been selected in the Parameter Filtering
view, the Add Parameter button opens the selected parameter.
The changes are made to the selected parameter.

When using SPA parametrisation, the Parameter field in the tool specifies the used SPA
parameter (for example 052S002). The syntax is [SPA Channel][SPA Data Category][SPA
Data Number].

When using IEC 61850 parametrisation, the Parameter field in the tool specifies the
used IEC 61850 Data (for example LD0.PHIPTOC1.StrValMult.setMag.f). The syntax
is [Logical Device].[Logical Node].[Data Object].[Data Attribute].

Adding new parameters for Modbus IEDs

If a connectivity package is not available for Modbus IEDs, the parameters can be added
manually. When Parameter Filtering Tool is launched from Modbus IED on SAB600
for the first time, there are no configured parameters in Parameter Filtering Tool. You
can add new parameters using the Add Parameter Form window.

To add a new parameter:
1. Click Add Parameter in the Parameter Filtering view. The Add Parameter Form

window opens, see Figure 3.12-3.
2. In the Add Parameter Form window, fill in the information of the parameter.
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• For the Modbus IED Read only parameter, specify only the parameter address.
• For Write and Read And Write parameter, in addition to the parameter address,

you may need to specify the password address and value, if the password is
enabled in the IED. You may also need to specify the execute address and
confirm address, if required by the IED.

3. After you have added all the necessary information, click Apply to add the parameter
to the Parameter Filtering view.

Add Parameter for Modbus IED.bmp

Figure 3.12-3 Adding a parameter for Modbus IED

Exporting parameters

You can export the information of the selected parameters to an Excel or XML file.

You can import the XML file back to the tool for other IEDs,
but you cannot import the parameters back to the tool from
the Excel file.

To export the parameter selection:
1. Select the parameters you want to export.
2. Click Export. Select the file type (Excel or XML).
3. Select the folder where you want to export the file and click Save.
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Export.bmp

Figure 3.12-4 Exporting XML file

Importing parameters

With the Import function it is possible to import an existing Parameter Filtering Tool
configuration for example from another computer. An XML file created with the Para-
meter Filtering Tool can be imported into another device or project using this tool.

Disturbance data upload3.13.

The basic support for the disturbance data upload (data upload and conversion to
COMTRADE format) is implemented to each OPC Server. Protocol and device-specific
differences are hidden from the OPC client. The files are stored temporarily to the
COM600 computer, where they can be transferred further using for example ftp. COM600
has a possibility to activate the disturbance data upload from the IED and to receive the
file into the computer where WebHMI is run.

If the IED and the OPC server used for communication support disturbance data upload,
the properties for configuring the function can be found from the corresponding OPC
server user's manual, see 1.10, Related documents.

Project-specific localization3.14.

With SAB600 you can modify the project-specific texts that are displayed in WebHMI.
Static WebHMI texts, for example menus and headers, can be translated by the local
ABB. For more information on localization, contact your local ABB representative.

To localize objects in the substation structure or communication tree:
1. Select the object you want to modify.
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2. Right-click the object and select Rename.
3. Modify the name of the object.

To localize object properties:
1. Select the object you want to modify in the Substation or Communication structure.
2. Right-click the object and select Properties. The Object properties window opens.
3. Modify the text properties of the object.

COM600 – Custom logo in WebHMI

It’s possible to define a custom logo that will be displayed on the COM600 WebHMI.

This is done by adding an image file named “logo.*” to the folder “C:\Program
Files\COM610 GW SW\WebHMI\custom_logo” on the COM600.

The logo file should be an image file type that can be displayed in web browsers, e.g.
PNG, GIF or JPG. Usually a PNG file will work best as it is then possible to have a
transparent background so that the logo image appears in a seamless way when displayed
with the WebHMI.

The custom logo image will be displayed in the center of the WebHMI header. It should
be sized appropriately so that it fits - images too large will be clipped. The width of the
header varies depending on the browser window width and the height is currently always
54 pixels.

If several files named “logo.*” are added to the folder, the first one found will be used.

After adding the logo file to the folder, simply open or refresh the WebHMI in the web
browser to see how the logo appears there.
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Example:

COM600_Custom_logo_adding.png

Figure 3.14-1 COM600 custom logo

COM600_Custom_logo.png

Figure 3.14-2 COM600_Custom_logo
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Appendix 1

Single Line Diagram symbols

Table A1-1 Single Line Diagram symbols
RemarksANSI2

represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Annotation

Alarm indicator in a branch of the
substation. Use at any level in the
structure to indicate alarms gener-
ally, or a specific alarm. The
indicator is not visible in the web
view when there are no active
alarms.

Alarm Indicator

Binary indicator (on/off, auto-
matic/manual, X/not-X, and so
on). It can also be used to send a
command.

Two State Switch

Hyperlink to external information
source, such as a web page or a
local file on COM600.

Files should be stored under
C:\Program Files\COM600 GW
SW\WebHMI\UserDocs\. The total
size of the files should not exceed
100 MB. Link syntax for local files
is: http://<COM600 IP
address>/HMI/UserDocs/<file-
name>

Launch Web Page

Use to send a single command to
one target.

Push Button

Use to launch an application
external to COM600

Application Launch

Measurement Text Box
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Button with multiple states (at
least 2). Each state has to be
configured. For each state
optional color and text can be
configured. This button can be
used e.g to show the status of
sequence step or health of an
IED.

Multiple State Button

ViaPoint

Connectivity Node

Circuit breaker – Inter-
mediate position

Circuit breaker – Open
position

Circuit breaker – Closed
position

Circuit breaker – Bad
(faulty) position

Disconnector – Interme-
diate position

Disconnector – Open
position

Disconnector – Closed
position

Disconnector – Bad
(faulty) position

Truck – Intermediate
position

Truck – Open position

Truck – Closed position

Truck – Bad (faulty)
position

Three State Switch
(Left, earthed)
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Three State Switch
(Right, earthed)

Load breaker – Interme-
diate position

Load breaker – Open
position

Load breaker – Closed
position

Load breaker – Bad
(faulty) position

Contactor – Intermedi-
ate position

Contactor – Open posi-
tion

Contactor – Closed
position

Contactor – Bad (faulty)
position

Primary winding: on top. Second-
ary winding: below. All composing
elements exist as individual sym-
bols.

Power Transformer with
two Windings and no
Tap Changer

Primary winding: on top. Second-
ary winding: below. All composing
elements exist as individual sym-
bols.

Power Transformer with
two Windings and Tap
Changer

Primary winding: on top. Second-
ary winding: below left. Tertiary
winding: below right. All compos-
ing elements exist as individual
symbols.

Power Transformer with
three Windings and no
Tap Changer

Primary winding: on top. Second-
ary winding: below left. Tertiary
winding: below right. All compos-
ing elements exist as individual
symbols.

Power Transformer with
three Windings and Tap
Changer

Voltage Transformer
(measurement)

Current Transformer
(measurement)
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Capacitor

Reactor

Generator

Motor

In-feeder

Out-feeder

Earth symbol

Bay Switch Indicator

Station Switch Indicator

Display Voltage

Five State Switch Left
Earthed

Five State Switch Right
Earthed

Power Cable

Gas Insulated Line

Power Overhead Line
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Appendix 2

SAB600 Toolbar

DescriptionSymbol

Displays the Substation and Communication Structure in the Project Explorer window.

Displays the Object Properties window.

Displays the messages in the Output window.

Displays a list of the object types.

Selects an object in the SLD Editor window.

Enables navigation of the SLD Editor window using a mouse.

Displays a grid view in the SLD Editor window.

Zooms in/out the SLD Editor window.

Opens the direct link tool.

Rotates the selected objects left in the SLD Editor window.

Rotates the selected objects right in the SLD Editor window.

Used to draw rectangles around grouped objects
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Appendix 3

Logical nodes and primary objects

Logical nodes can be connected to primary objects according to the following table. If
no specific function is written in the Comment column, the connection is used for dis-
playing the substation structure based on identification for the events and alarms.

Table A3-1 Logical node classes and primary objects
CommentMandatoryLN ClassPrimary object

Substation

Loc data used for sta-
tion/remote switch
state

LLN0

SIMG

CALH

M*

G*

Q*

Voltage Level

SIMG

CALH

M*

G*

Q*

Bay

Loc data used for bay
local/remote switch
state

LLN0

LPHD

SIMG

SARC

SIML

SPDC

CALH

M*

P*

R*
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CommentMandatoryLN ClassPrimary object

G*

T*

Q*

Circuit Breaker (CBR)

XCBR

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Disconnector (DIS)

XSWI

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Voltage Transformer
(VTR)

TVTR
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CommentMandatoryLN ClassPrimary object

CALH

G*

Current Transformer
(CTR)

TCTR

SARC

SPDC

CALH

G*

Q*

Power Overhead Line
(LIN)

ZLIN

CALH

G*

Rotating Reactive
Component (RRC)

ZRRC

CALH

G

Surge Arrestor (SAR)

ZSAR

CALH

G

Thyristor controlled
frequency converter
(TCF)

ZTCF

CALH

G

Thyristor controlled
reactive component
(TCR)

ZTCR

CALH

G*
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CommentMandatoryLN ClassPrimary object

Power Transformer
Winding (PTW)

G*

Powered rules for the
Incoming Feeder Line
can be configured in
the SLD editor. See
3.5.1 Configuring the
powered state for
incoming feeder and
generator.

Incoming Feeder Line
(IFL)

CALH

G*

Q*

Powered rules for the
Generator can be con-
figured in the SLD
editor. See 3.5.1 Con-
figuring the powered
state for incoming
feeder and generator.

Generator (GEN)

ZGEN

G*

Capacitor Bank (CAP)

CapDs and DschBlk

data used for Capa-
citor Bank status in
control dialogues.

ZCAP

G*
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